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B.1. INTRODUCTION TO STRUCTURAL EQUATION MODELING
 INITIAL DEFINITIONS

 SEM is an extension of Generalized Linear Models;

 It is a technique of generalized modeling (theoretical models on how different latent variables or 
constructs are operationalized and how they are related to each other);

 Allow measurement errors to be explicitly considered.

 In simplistic terms:

SEM Factorial Analysis
(measurement model)

Linear Regression
(structural model)= +

B.1. INTRODUCTION TO STRUCTURAL EQUATION MODELING
 INITIAL DEFINITIONS

 SEM Definition:
 “Structural equation modeling (SEM) does not  designate a single statistical technique but instead refers to a 

family of related procedures. Other terms such as covariance structure analysis, covariance structural 
modeling, or analysis of covariance structures are essentially interchangeable. Another term (…) is causal 
modeling, which is used mainly in association with the technique of path analysis.” (Kline, 2005, p. 9)

 SEM techniques are known as the second generation of data analysis techniques (Bagozzi & Fornell, 1982).

Primarily ConfirmatoryPrimarily exploratory
 Analysis of variance
 Logistic regression
 Multiple regression
 Confirmatory factor analysis

 Cluster analysis
 Exploratory factor analysis
 Multidimensional scalling

First-generation
techniques

 Covariance-based structural
equation modeling (CB-SEM)

 Partial least squares structural
equation modeling (PLS-SEM)

Second-generation
techniques

Source: Hair et al., 2017, p. 2.
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B.1. INTRODUCTION TO STRUCTURAL EQUATION MODELING
 INITIAL DEFINITIONS

 It differs from most of first-generation regression models such as linear regression, Logit, ANOVA or MANOVA, 
because these techniques are only able to analyze one set of relationships between independent and dependent 
variables at a time (Gefen et al., 2000).

 Compared to linear regression, SEM has the advantage to analyze path diagrams with latent variables with multiple 
indicators (Gefen et al., 2000).

 Even when the constructs included in a model are observable variables (e.g. number of patents, international 
experience in years, price variation, growth of sales, ROS, ROE, etc), compared to linear regression SEM has 
advantages related with the creation and estimation of models that simultaneously include several dependent and 
independent variables.

 So in a glance, why is SEM so popular today?
 Not all variables involved in a particular “phenomenon” are manifest, that is, observable or directly manipulable;
 Increased complexity of theoretical models capable of explaining a given event;
 SEM allows for the modeling and testing of relationships among multiple independent and dependent constructs, all at 

once. 
 Software for SEM are easy to use.

B.1. INTRODUCTION TO STRUCTURAL EQUATION MODELING
 PLS-SEM vs CB-SEM

 Some authors argue that SEM techniques can be:
 Covariance-based (CB-SEM) – LISREL, AMOS, EQS, Mplus; SePath;
 Variance-based or partial least squares (PLS-SEM): SmartPLS, WarpPLS, PLS Graph, ...

 The most important reason to select CB-SEM or PLS-SEM is the research goal (Hair et al., 2011):
 If the goal is theory testing, theory confirmation, or comparison of alternative theories, select CB-SEM.
 If the research is exploratory or an extension of an existing structural theory, select PLS-SEM.
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B.1. INTRODUCTION TO STRUCTURAL EQUATION MODELING
 PLS-SEM vs CB-SEM

 It all starts with Swedish econometrician Herman Wold (1908-1992):
 He was PhD supervisor of Karl Jöreskog – one of the LISREL CB-SEM software developers;
 He was also PhD supervisor of Jan-Bernd Lohmöller – one of the first authors to write about PLS.

 Wold called CB-SEM as hard modeling and PLS-SEM as soft modeling.

 Wold developed the variance-based SEM or PLS-SEM in the 1970s (Wold, 1973; 1975), but the software packages 
that explore PLS-SEM only appear much years later:
 PLSGraph – Chin, 1990s;
 SmartPLS – Ringle, Wende and Will, 2005;
 WarpPLS – Kock, 2009.

 The first commercial version (version 3) of LISREL software (CB-SEM) was released in 1975.

 Jöreskog & Wold (1982) classified CB-SEM and PLS-SEM as complementary approaches, instead of competitive.

 Wold recognized CB-SEM potential for social sciences but (Hair et al., 2011; Dijkstra, 2010):
 He was concerned with the distributional requirements that he classified as unrealistic for empirical research;
 He believed that it emphasized estimation and description too much and prediction too little.

B.1. INTRODUCTION TO STRUCTURAL EQUATION MODELING
 PLS-SEM vs CB-SEM

 PLS-SEM and CB-SEM are applied when unobserved variables are included in the model, but they 
employ different algorithms and have different objectives (Richter et al., 216).

 CB-SEM is a factor-based approach of SEM  while PLS-SEM is a composite-based form of SEM 
(Rigdon et al., 2017).

 CB-SEM considers a construct as a common factor and focuses on minimizing the difference 
between the model-implied and empirical covariance matrices (Rigdon et al., 2017);

 PLS-SEM focuses on the maximization of explained variance of endogenous constructs and is a 
more prediction-oriented approach (Rigdon et al., 2017; Cepeda-Carrión et al., 2016; Shmueli et 
al., 2016).
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B.1. INTRODUCTION TO STRUCTURAL EQUATION MODELING
 CB-SEM vs PLS-SEM

 Some differences between the two SEM methods:

PLS-SEMCB - SEM

The model parameters are estimated in order to maximize the 
explained variance of the endogenous latent variables.

The model parameters are estimated in order to minimize the 
difference between the estimated and sample covariance matrices.

Prediction oriented, and thus optimal for prediction accuracy.Parameter oriented, and thus optimal for parameter accuracy.

Makes no distributional assumptions.Considers multivariate normal distribution.

Works with small sample sizes. Recommendations for the minimum 
number of observation: 30 - 100.

Requires high sample sizes. Recommendations for the minimum 
number of observation: 200 – 800.

Defines convergence as the point at which no substantial difference 
occurs from one iteration to the next.

Defines convergence as the increase/decrease in the function value 
beyond a certain threshold.

No (established) goodness-of-fit statistics.Included goodness-of-fit statistics.

Supports reflective and formative indicators.Typically, only supports reflective indicators.

Calculates constructs as composites of indicators: the total variance is 
used to estimate model parameters.

Calculates constructs as common factors: common variance is used to 
estimate model parameters.

Source: Adapted from Hair et al., 2017; Sarstedt, Ringle & Hair, 2014.

B.1. INTRODUCTION TO STRUCTURAL EQUATION MODELING
 VARIABLES

 Both SEM start in the same point:
 Manifest or observed variables (or indicator or item) 

These variables are measured or observed directly;

 Latent variables, factors or constructs 
These variables are not directly observable or measured;
Some examples are related with beliefs, intentions and feelings;
Their ‘existence’ is indicated by their manifestation in indicator or manifest variables.

Latent
variableObserved

variables
Measurement

errors

Residuals

Paths
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B.1. INTRODUCTION TO STRUCTURAL EQUATION MODELING
 VARIABLES

 Both types of variables (latent or manifest) can be independent or dependent:
 Independent variables (or exogenous variables)
The causes of these variables reside outside the model, thus they are not influenced by any other variable in the model.

 Dependent variables (or endogenous variables)
The causes of the variation of these variables reside in the model, thus the variation of these variables is explained by 
variables in the model.

Variable A

Variable B

Variable C

H1

H3

H2

CB-SEM CHAPTER B.2
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Introduction to CB-SEM & AMOS B.2.1

B.2.1. INTRODUCTION TO STRUCTURAL EQUATION MODELING
MEASUREMENT AND STRUCTURAL  MODEL

 The SEM presents usually two different components:
o Measurement Model: Defines the way the latent variables are operationalized/ measured by observed 

variables.

o Structural Model: Defines the causal or association relations between latent variables.
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B.2.1. INTRODUCTION TO STRUCTURAL EQUATION MODELING
STEPS

 Steps:

Theoretical
Model

Specification
and

identification
of the model

Data 
Collection

Model
Estimation

Assessment
of

Adjustment
Quality

Model
Validation

Conclusions

B.2. INTRODUCTION TO STRUCTURAL EQUATION MODELING
 SAMPLE

 Sample dimension:

 Minimum of 200 cases (Boomsma, 1985);

 10 cases per variable (Nunnally, 1967);

 Rule of thumb 10:1 or 5:1, comparing the number of observations and the number of 
estimated parameters (Bentler & Chou, 1987; Bollen, 1989);
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Creating Projects with AMOS B.2.2

B.2.2. CREATING PROJECTS WITH AMOS
EXISTING SOFTWARES

Examples of CB-SEM softwares:
oAMOS;

oLISREL;

oEQS;

oMplus;

oSePath;

o…
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B.2.2. CREATING PROJECTS WITH AMOS
FIRST STEPS

1 . Click on the data file icon
OR

Go to Files > Data Files 
OR

Ctrl+D

2 . Select the data file.

B.2.2. CREATING PROJECTS WITH AMOS
FIRST STEPS

3. Select Strategies.sav file.

4. Click ‘OK’.

AMOS accepts several types of data 
files, such as *.dbf; *.csv; *.txt; *.xls; 

*.xlsx and *.sav files.

5. To see variables, you
should click on the variables

icon.
OR

View>Variables in dataset.
OR

Ctrl+Shift+D

6. This list will appear
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B.2.2. CREATING PROJECTS WITH AMOS
FIRST STEPS

7. Save the project:
*Use the save icon

OR
*File>Save

OR
Ctrl+S

B.2.2. CREATING PROJECTS WITH AMOS
INITIAL SCREENING

But before we advance, we need to do the initial screening of data:

oMissing data in rows (analysis by case)  Use Excel or SPSS;

oMissing data in columns (analysis by variable)  Use Excel or SPSS;

oUnengaged responses  Use Excel or SPSS;

oOutliers (relevant for continuous variables)  Use SPSS;

oNormality (Kline, 2015)  Use SPSS:

o Skewness: needs to be less than |10|; 

o Kurtosis: needs to be less than |3|.

Other issues:

oNonresponse bias (comparison between first 75% responses with last 25% responses);

oCommon-method bias (Harman’s one factor).
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 But first, we need to know more about the conceptual model.

Innovation
Differentiation

Marketing 
Differentiation

International
Performance

B.2.2. CREATING PROJECTS WITH AMOS
FIRST STEPS (example)

Quality & 
Service 

Differentiation

Cost Leadership

Measures:
INNOVATION DIFFERENTIATION (Beal., 2000)
(seven-point Likert scale anchored with 1=‘Much worse than main competitors’ to 7=‘Much better than main competitors’ )

R&D of new productsGst_it1
Marketing of new productsGst_it2
Selling high-priced productsGst_it3

MARKETING DIFERENTIATION (Beal., 2000) 
(seven-point Likert scale anchored with 1=‘Much worse than main competitors’ to 7=‘Much better than main competitors’ )

Obtaining patents or copyrightsGst_it4
Innovative marketing techniquesGst_it5
Building brand/company identificationGst_it6
Advertising/promotional programsGst_it7
Securing reliable distribution channelsGst_it8

QUALITY & SERVICE DIFERENTIATION (Beal., 2000)
(seven-point Likert scale anchored with 1=‘Much worse than main competitors’ to 7=‘Much better than main competitors’ )

Improving existing productsGst_it9
Strict product quality controlGst_it16
Immediate resolution of customer problemsGst_it19
Product improvements based on gaps in meeting customer expectationsGst_it20
New customer servicesGst_it21
Improvement of existing customer servicesGst_it22

B.2.2. CREATING PROJECTS WITH AMOS
FIRST STEPS (example)

25
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Measures:
COST LEADERSHIP (Beal., 2000) 
(seven-point Likert scale anchored with 1=‘Much worse than main competitors’ to 7=‘Much better than main competitors’ )

Improving efficiency and productivityGst_it11
Developing new manufacturing processesGst_it12
Improving existing manufacturing processesGst_it13
Reducing overall costsGst_it14
Reducing manufacturing costsGst_it15

INTERNATIONAL PERFORMANCE (Jantunen et al., 2008)
(seven-point Likert scale anchored with (1 = Very unsatisfied; 7 = Very satisfied) )

Sales volumeIPerf_it1
Market shareIPerf_it2
ProfitabilityIPerf_it3
Market entryIPerf_it4
Image developmentIPerf_it5
Knowledge developmentIPerf_it6

B.2.2. CREATING PROJECTS WITH AMOS
FIRST STEPS (example)

 Our database:
o Empirical data used to test the hypotheses was drawn from a online structured questionnaire 

conducted in 2011;

o Population: 

o Multi-industry Portuguese new ventures (1.993 eligible firms);

o Weight of foreign sales was defined as 25% of total sales.

o Firms took 6 or less years to achieve that weight in the total sales.

o Initial pretest with a dozen firms;

o Initial contact with firms by telephone;

o Final sample: 319usable responses (response rate of 20.9%).

 Reference:
o Crespo, N.F., Simões, V.C. & Fontes, M. (2020), Competitive strategies and international new 

ventures' performance: Exploring the moderating effects of internationalization duration and 
preparation, Business Research Quarterly, 23(2), p. 120-140. 

B.2.2. CREATING PROJECTS WITH AMOS
FIRST STEPS (example)
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 Let’s setup our model. Two options:
 Using the latent variable option (EASIER);
 Design each latent variable by hand.

B.2.2. CREATING PROJECTS WITH AMOS
FIRST STEPS

1a. Latent Variable option.

1b. Design by hand.

Maybe we need to explain all the
controls available.

 Now let’s start to include the items:

B.2.2. CREATING PROJECTS WITH SMARTPLS
FIRST STEPS

2. We will drag the respective
variables to the respective

items.
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 Latent variables names:

B.2.2. CREATING PROJECTS WITH SMARTPLS
FIRST STEPS

3. Like this!

4. Give Latent variables a 
name.

 Errors names:

B.2.2. CREATING PROJECTS WITH SMARTPLS
FIRST STEPS

5. Like this!

6. Now, let’s give some names
to the errors!

7. Easy: Plugins > Name
Unobserved variables.
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 Errors names:

B.2.2. CREATING PROJECTS WITH SMARTPLS
FIRST STEPS

8. We get these names e…

Measurement Models B.2.3
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 Include covariances:

B.2.3. MEASUREMENT MODEL
INTRODUCTION

1a. Manually: Use ‘draw
covariances tool

1b. Easier way: Select all
latent variables +  

Plugins>Draw covariances.

 Save the model:

B.2.3. MEASUREMENT MODEL
INTRODUCTION

2. Like this!

3. Save

4. Give name: Measurement
Model
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 Run de model:

B.2.3. MEASUREMENT MODEL
INTRODUCTION

5a. Click on the Analysis
Properties icon!

5b. View> Analysis
Propperties.

6. Select:
*Standardized estimates;
*Squared multiple
correlations;
*Modification indices.

 Run the model:

B.2.3. MEASUREMENT MODEL
INTRODUCTION

7a. Click on the Abacus!

7b. Analyse> Calculate
Estimates.
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 See the results:

B.2.3. MEASUREMENT MODEL
INTRODUCTION

8a. Click on the View text
icon.

8b. View> Text output
OR
F10

 See the results:

B.2.3. MEASUREMENT MODEL
INTRODUCTION

9. This report appears.

10. Let’s do a jam session on
the report.
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Evaluating CB-SEM Models B.2.4

B.2.4. EVALUATING CB-MODELS
 STEPS

 The two-stages process is followed (Anderson and Gerbing, 1988; Hair et al., 2019):
 STAGE 1: Measurement model
 STAGE 2: Structural model.

 Measurement Models:
 Reflective measurement models.

 Structural Models.

Reliability

Assessment of relations

 
Validity

Model Fit
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B.2.4. EVALUATING CB-SEM MODELS
 STEPS

 ASSESSMENT OF REFLECTIVE MEASUREMENT MODELS:
Cut-offMeasurement Model

≥0.60 or ≥0.70
(Bagozzi & Yi, 1988, 2012)

Loadings of the items

Unidimensionality & 
Reliability

≥0.70
(Cronbach, 1951)

Cronbach’s Alpha

CR≥0.60 or CR≥0.70
(Hair et al., 2009; Bagozzi & Yi, 2012)

Composite Reliability (CR)

≥0.60 or ≥0.70
(Bagozzi & Yi, 1988, 2012)

Loadings of the items

Convergent Validity
CR≥0.50

(Hair et al., 2008)
Average Variance Extracted (AVE)

CR≥0.50
(Hair et al., 2008)

Average Variance Extracted (AVE)

Discriminant Validity
AVE > r2 or AVE>r

(Fornell & Larcker, 1981)
AVE vs r2

B.2.4. EVALUATING CB-SEM MODELS
 STEPS

 ASSESSMENT OF REFLECTIVE MEASUREMENT MODELS:
 Loadings of the items:

1. Look at the Standardized
Regression Weights.

It seems that here we have a 
problem. Less than 0.60… 

But let’s see if this is
problematic…
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B.2.4. EVALUATING CB-SEM MODELS
 STEPS

 ASSESSMENT OF REFLECTIVE MEASUREMENT MODELS:
 CR and AVE:

2. Open the Excel file 
‘Stats_Tools_Package.xlsx’.

3. Go to the ValidityMaster
sheet.

4. Copy & Paste both
Correlations table and

Standardized Regression
Weights table.

B.2.4. EVALUATING CB-SEM MODELS
 STEPS

 ASSESSMENT OF REFLECTIVE MEASUREMENT MODELS:
 CR and AVE:

5. Press on this button to 
start a Macro
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B.2.4. EVALUATING CB-SEM MODELS
 STEPS

 ASSESSMENT OF REFLECTIVE MEASUREMENT MODELS:
 CR and AVE:

6. You will get this Table.
Here we can see:

• CR;
• AVE

and
• Fornell & Larcker Criteria.

B.2.4. EVALUATING CB-SEM MODELS
 STEPS

 ASSESSMENT OF REFLECTIVE MEASUREMENT MODELS:
 Cronbach’s Alpha:

7. In the SPSS, open the File 
Strategies.sav
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B.2.4. EVALUATING CB-SEM MODELS
 STEPS

 ASSESSMENT OF REFLECTIVE MEASUREMENT MODELS:
 Cronbach’s Alpha:

8. Analyse > Scale > Reliability
Analysis

OR
Analisar > Escala > Análise de 

Confiabilidade

B.2.4. EVALUATING CB-SEM MODELS
 STEPS

 ASSESSMENT OF REFLECTIVE MEASUREMENT MODELS:
 Cronbach’s Alpha:

9. For each latent variable, 
include the items that measure

the variable.
Then, press ok.
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B.2.4. EVALUATING CB-SEM MODELS
 STEPS

 ASSESSMENT OF REFLECTIVE MEASUREMENT MODELS:
 Model Fit:

Cut-offFit Index

3.0 - 5.0: medíocre fit.
2.0 - 3.0: good fit.

2/df

(Normed Chi-square)

0.06: good fit;
0.06-0.08: reasonable fit;

0.08-0.1: mediocre fit;
>0.1: poor fit.

RMSEA

(Root Mean Square Error of Approximation)

>0.90: good fit.GFI

(Goodness-of-Fit Index)

>0.90: good fit.NFI

(Normed Fit Index)

>0.90: good fit.CFI

(Comparative Fit Index)

>0.90: good fit.IFI

(Incremental Fit Index)

Source: Based on Diamantopoulos & Siguaw, 2008; Bagozzi & Yi, 2012; Vieira, 2010; Iacobucci, 2010, Hooper el al, 2008; Hair et al. 2019.

B.2.4. EVALUATING CB-SEM MODELS
 STEPS

 ASSESSMENT OF REFLECTIVE MEASUREMENT MODELS:
 Model Fit:

11. In the Report section, go to 
Model Fit.

12. The indices are not
Exceptional, but we can 

improve the fit.

13. Go to Modification Indices, 
and identify the highest values, 

suggesting the covariances
between errors of variables.
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B.2.4. EVALUATING CB-SEM MODELS
 STEPS

 ASSESSMENT OF REFLECTIVE MEASUREMENT MODELS:
 Model Fit:

14. For instasse, include a 
covariance between e12 and
e13, will improve the X2 in 

118,31.

B.2.4. EVALUATING CB-SEM MODELS
 STEPS

 ASSESSMENT OF REFLECTIVE MEASUREMENT MODELS:
 Model Fit:

11. In the Report section, go to 
Model Fit.

12. The indices are not
Exceptional, but we can 

improve the fit.

13. Go to Modification Indices, 
and identify the highest values, 

suggesting the covariances
between errors of variables.
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B.2.4. EVALUATING CB-SEM MODELS
 STEPS

 ASSESSMENT OF REFLECTIVE MEASUREMENT MODELS:
 Model Fit:

14. Include the variance
between e12 and e13.

15. Run the model.

16. Repeat the process until no 
modification indices appear.

B.2.4. EVALUATING CB-SEM MODELS
 STEPS

 ASSESSMENT OF REFLECTIVE MEASUREMENT MODELS:
 Model Fit:

17. The values improve:
• X2/df=2.975
• GFI=0.813
• CFI=0.879
• IFI=0.880
• NFI=0.829
• RMSEA=0.083

55

56



PROGRAMA DE DOUTORAMENTO EM GESTÃO
Técnicas Quantitativas de Investigação em Gestão

© Nuno Crespo 2023 29

Structural Model B.2.5

B.2.5. STRUCTURAL MODEL

 Let’s organize the model:

1 . Move the variables
according to the alignment

of the conceptual 
framework.

2 . Remove the covariances
between independent and

dependent variables.
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B.2.5. STRUCTURAL MODEL

 Let’s organize the model:

3 . Now we need to connect
these variables.

B.2.5. STRUCTURAL MODEL

 Let’s organize the model:

4 . We include these arrows, 
like presenting causality

beween the strategies and
the performance.

5 . We also include this for 
the residuals.

59

60



PROGRAMA DE DOUTORAMENTO EM GESTÃO
Técnicas Quantitativas de Investigação em Gestão

© Nuno Crespo 2023 31

B.2.5. STRUCTURAL MODEL

 Let’s organize the model:

6 . Next step: Run the
model! 

(i.e. Calculate estimates)

B.2.5. STRUCTURAL MODEL

 Let’s organize the model:

7 . The results shows that
only Quality & Service

Differentiation promote
International Performance.

8 . You report the
standardized estimates, with

the p-values presented in 
the Regression weight table.
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B.2.5. STRUCTURAL MODEL

 Let’s organize the model:

7 . The results shows that
only Quality & Service

Differentiation promote
International Performance.

8 . You report the
standardized estimates, with

the p-values presented in 
the Regression weight table.

B.2.5. STRUCTURAL MODEL

 Let’s organize the model:

9 . You also show the Model
fit for the structural model.
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Mediation B.2.6

 A variable functions as a mediator when it meets 
the following conditions (Baron & Kenny, 1986):

o Variations in levels of the independent variable 
significantly account for variations in the 
presumed mediator (i.e. Path a)

o Variations in the mediator significantly account 
for variations in the dependent variable (i.e. Path 
b), and

oWhen paths a and b are controlled, a previously 
significant relation between the independent and 
dependent variables (i.e. Path c) is no longer 
significant.

B.2.6. MEDIATION
DEFINITION

Mediator
Variable

Independent
Variable

Dependent
Variable

Path bPath a

Path c

65

66



PROGRAMA DE DOUTORAMENTO EM GESTÃO
Técnicas Quantitativas de Investigação em Gestão

© Nuno Crespo 2023 34

 Partial Mediation:

o The independent variable still has a significant direct 
effect on the dependent variable.

o The magnitude of the influence of Path c is diminished 
(but still significant) upon introducing the mediator 
variable (and Paths a and b).

 Full Mediation:

o The independent variable does not have a significant 
effect on the dependent variable after inclusion of the 
mediator variable. That is, the effect of the 
independent variable on the dependent variable is not 
significantly different from zero.

o The magnitude of the effect of Path c drops to zero.

B.2.6. MEDIATION
DEFINITION

Mediator
Variable

Independent
Variable

Dependent
Variable

Path bPath a

Path c

The framework Strategy-Resources-Performance, may be explored here.

Let’s consider the Firm Resource variable:
FIRM RESOURCES (Wu, Wang, Chen & Pan, 2008)
(seven-point Likert scale anchored with strongly disagree to strongly agree)

The specialized expertise of the firm was above the industry average.FR_it1
Firm capital was above the industry average.FR_it2
The operational management capability of the companywas above the industry average.FR_it3
The reputation of the company was above the industry average.FR_it4
The cooperative aliance experience of the company was above the industry average.FR_it5

B.2.6. MEDIATION
Example

Firm Resources

Innovation
Differentiation

International
Performance

Marketing
Differentiation

Quality & Service
Differentiation

Cost
Leadership
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We need to redo the measurement model, with this additional variable:

B.2.6. MEDIATION
Example

1. We got this problem
with the AVE of Firm

Resources.

2. Maybe we can solve 
that by excluding FR_it5 
and FR_it2, with loading

below 0.60.

We need to redo the measurement model, with this additional variable:

B.2.6. MEDIATION
Example

3. Like this. 4. Everything OK.
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Now the structural model:

B.2.6. MEDIATION
Example

6. All dependent
variables need to include

the residuals.

5. Like this.

 Initially, we had:

B.2.6. MEDIATION
Example

Innovation
Differentiation

International
Performance

Marketing
Differentiation

Quality & Service
Differentiation

Cost
Leadership

0.413n**

-0.024n.s.

0.141n.s.

0.076n.s.
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And now we have:

Hence, it seems that:

oThe direct effect that Quality & Service Differentiation has on International 
Performance, is partially mediated by Firm Resources.

B.2.6. MEDIATION
Example

Firm Resources

Innovation
Differentiation

International
Performance

Marketing
Differentiation

Quality & Service
Differentiation

Cost
Leadership

0.412***

-0.052n.s.

0.105n.s.

0.044n.s.

0.379***

0.284***

PLS-SEM CHAPTER B.3
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Introduction to PLS-SEM & 
SmartPLS

B.3.1

B.3.1. INTRODUCTION TO STRUCTURAL EQUATION MODELING
INNER MODEL AND OUTER MODEL

 Measurement Model:
o In PLS-SEM the measurement model is called outer model.
o Relationships between each latent variable and their observed indicators.
o The same indicator can not be associated to different latent variables, that is multiple relations are not possible 

(Hair et al., 2011).

 Structural Model:
o In PLS-SEM the structural model is called inner model.
o The paths between the latent variables can only head in a single direction (Hair et al., 2011). In other words, 

causal loops are not possible.
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B.3.1. INTRODUCTION TO STRUCTURAL EQUATION MODELING
INNER MODEL AND OUTER MODEL

Entrepreneurial
Orientation

Absorptive
Capacity

Entrepreneurial
Alertness

Foreign Market
Knowledge

EO_it1
EO_it2
EO_it3
EO_it4

FMK_it1
FMK_it2
FMK_it3
FMK_it4

AC_it1
AC_it2
AC_it3
AC_it4

EA_it1
EA_it2
EA_it3
EA_it4

Outer Model
Endogenous

Outer Model
Exogenous

Inner Model

B.3.1. INTRODUCTION TO STRUCTURAL EQUATION MODELING
WHY PLS-SEM? + SAMPLE

 Reasons used by researchers to choose PLS-SEM as the statistical approach for assessing 
structural equation models (Urbach & Ahlemann, 2010):
 It is less demanding than other methods about the sample size (10:1 rule; minimum of 100);
 It is not necessary to have normal-distributed data;
 Can handle with both reflective and formative latent variables;
 Addresses better theory development than theory testing;
 It is particularly valuable for prediction;
 Can be used for complex structural equation models with a large number of constructs;
 …

 Sample rule of thumb 10:1:
 In formative variables identify the maximum number of indicators that is used to measure a latent 

variable (LV);
 In the inner model (including formative and/or reflective variables), identify the LV with the 

maximum number of exogeneous (independent) LV;
 The maximum between those two values is multiplied by 10, and we obtain the minimum 

sample size.
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B.3.1. INTRODUCTION TO STRUCTURAL EQUATION MODELING
 REFLECTIVE vs FORMATIVE

 Each construct is associated with one or more indicators or items (observed variables).

 We can identify three different outer model “modes” (Hair et al., 2011; Rigdon et al., 2010):
o Mode A – Reflective measurement model (scales);
o Mode B – Formative measurement model (indices);
o Mode C – “Mixed” measurement model:

o Different modes for different latent variables.
o Even so, is not possible to have both reflective and formative indicators for the same latent variable.

o PLS-SEM can handle with all these outer models.

B.3.1. INTRODUCTION TO STRUCTURAL EQUATION MODELING
 REFLECTIVE vs FORMATIVE

 REFLECTIVE INDICATORS
 These are seen as functions or “effects” of the latent variable; 
 Changes in the latent variables can be reflected in the indicators (observable variables);
 These can be represented in PLS-SEM by single headed arrows pointing away from the latent variable to 

the indicators;
 The coefficients related to these relationships are called outer loadings;
 Takes measurement error into account at the item level;
 Reducing an indicator or item does not alter the meaning of the construct. So, it is possible to have 

substitution or omission of items in subsequent studies.

Latent
Variable

it1
it2
it3
it4
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B.3.1. INTRODUCTION TO STRUCTURAL EQUATION MODELING
 REFLECTIVE vs FORMATIVE

 REFLECTIVE MEASUREMENT MODEL WITH SmartPLS
 Similar to factor analysis or principal component analysis (PCA); 
 Measurement errors are expected to be zero;
 Indicators should be positively correlated;
 The latent variables has a variance of one;
 Usually, the latent variable is centered, and the latent mean is calculated;
 The weights are calculated, also.


x1

X2

X3

X4

1

2

3

4

0
0
0
0

1
2
3
4

1

B.3.1. INTRODUCTION TO STRUCTURAL EQUATION MODELING
 REFLECTIVE vs FORMATIVE

 FORMATIVE INDICATORS
 These cause or form the latent variable; 
 Changes in the formative indicators “lead to changes” in latent variables;
 These can be represent in PLS-SEM by single headed arrows pointing from the indicators to the latent 

variable;
 Items are included to capture  the latent variable in its globality. So, dropping an indicator or item may 

alter the conceptual meaning of the construct.

Latent
Variable

it1
it2
it3
it4
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B.3.1. INTRODUCTION TO STRUCTURAL EQUATION MODELING
 REFLECTIVE vs FORMATIVE

 FORMATIVE MEASUREMENT MODEL WITH SmartPLS
 Based on multiple regression; 
 Measurement errors at construct level:

 Represent the missing indicators;
 Is expected to be zero.

 Indicators are not expected to be correlated, can be mutually exclusive. But multicollinearity can be a problem in 
formative items;

 The latent variable has a variance of one;
 Usually, the latent variable is centered, and the latent mean is calculated;
 Weights are estimated and rely on others variables, not the latent construct that they “form”;
 The correlations between the latent variable and its indicators (loadings) are also calculated.


x1

X2

X3

X4

w1
w2
w3
w4

1 0

B.3.1. INTRODUCTION TO STRUCTURAL EQUATION MODELING
 REFLECTIVE vs FORMATIVE

 Examples:

Drunkeness
Diziness

Speach Slurred

Slow reations

Drunkeness

Beer drunk

Wine consumed

Liquor

Formative

Reflective Satisfaction

I appreciate this hotel.

I’ am looking forward to staying in 
this hotel

I recommend this other to others.

Satisfaction

The service is good.

The personnel is friendly.

The rooms are clean.

Source: Adapted from Albers, 2010.
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Creating Projects with SmartPLS B.3.2

B.3.2. CREATING PROJECTS WITH SMARTPLS
EXISTING SOFTWARES

 Examples of PLS-SEM softwares:
oADANCO;

oGeSCA;

o LVPLS;

oPLSPATH (R software);

oPLS-Graph.

oPLS-GUI (R software);

oSPAD-PLS;

oSmartPLS – www.smartpls.com

oWarpPLS;

oVisual PLS;

oSome are paid and other are freeware.
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B.3.2. CREATING PROJECTS WITH SMARTPLS
INITIAL FEATURES

 Some information about the software (Temme, Kreis & Hildrebrandt, 2010):
o It is independent from the user’s operating system, because it is Java-based.

oUses raw data as input; 

o The specification of the model is done by drawing the structural model (with the latent variables) 
and allocating (using drag & drop) the items or indicators to the latent variables;

o The output reports, besides exhibited within the software, can be exported as Excel, HTML or R 
formats.

o Besides the PLS Algorithm, bootstrapping and blindfolding are the resampling methods available.

o It includes the specification of moderation effects and quadratic effects.

o Supports multigroup analysis;

oOther features: finite mixture routine (FIMIX), importance-performance map analysis (IPMA), PLS 
Predict, Confirmatory Tetrad analyses (CTA).

B.3.2. CREATING PROJECTS WITH SMARTPLS
FIRST STEPS

1 . Go to Files > New Project/ 
or click New Project

2 . Give your project a name
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B.3.2. CREATING PROJECTS WITH SMARTPLS
FIRST STEPS

3. Give your project a name
(I called it Project TAM)

4. This new Project apppears

5. Click on Insert data file, 
and select the file TAM.csv

SmartPLS accepts *.csv; *.txt; *.xls; 
*.xlsx and *.sav files.

6. Click Abrir/Open

B.3.2. CREATING PROJECTS WITH SMARTPLS
FIRST STEPS

7. This new tab will appear. 
Since our variables are Likert
type scales, classify them as 

‘Ordinal’.

8. In this case we have no missing 
values. If we did, they would be 
identified here. The existence of 
missing values will not affect the 

procedures.

9. Then, click import.
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11. By clicking ‘Back’, I will
return to the workspace.

B.3.2. CREATING PROJECTS WITH SMARTPLS
FIRST STEPS

10. Now you can 
inspect all descriptive
statistics of the items. 

12. This dataset is painted green. If was not
green, we had to go analyze the data.

B.3.2. CREATING PROJECTS WITH SMARTPLS
FIRST STEPS

13. Now we will click
on ‘Create a model’

14. Select PLS-SEM 15. Give a name to the
model. I name it as 

TAM_Model.

16. Save it.
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B.3.2. CREATING PROJECTS WITH SMARTPLS
FIRST STEPS

17. And we will get
the new workspace

view.

 But first, we need to know more about the conceptual model.

 Consider this Technology Acceptance Model (TAM)

Perceived 
Usefulness

Perceived 
Ease of Use

Attitude 
Toward Using

Behavioral 
Intention to 

Use

Actual 
Use

Belief Constructs and Attitudes Predicts Users

B.3.2. CREATING PROJECTS WITH SMARTPLS
FIRST STEPS (example)
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Measures:
PERCEIVED USEFULNES (Venkatesh et al., 2000)
(seven-point Likert scale anchored with strongly disagree to strongly agree)

I find computers useful in my job.USEF1
Using computers in my job enables me to accomplish tasks more quickly. USEF2
Using computers in my job increases my productivity.USEF3
Using computers enhances my effectiveness on the job.USEF4

PERCEIVED EASE OF USE (Venkatesh et al., 2000)
(seven-point Likert scale anchored with strongly disagree to strongly agree)

My interactions with computers are clear and understandable.EOU1
It is easy for me to become skillful using computers.EOU2
I find computers easy to use.EOU3
Learning to use computers is easy for me.EOU4

BEHAVIORAL INTENTION OF USE (Mathieson, 1991)
(seven-point Likert scale anchored with strongly disagree to strongly agree)

I predict I will continue to use computers on a regular basis.BI1
I predict I will use computers on a regular basis in the future.BI2
To do my work, I would use computers rather than any other means available.BI3

B.3.2. CREATING PROJECTS WITH SMARTPLS
FIRST STEPS (example)

Measures:
ATTITUDE TOWARD USING (Mathieson, 1991)
(seven-point Likert scale with different anchors)

All things considered, my using computers is (extremely bad ~ extremely good).ATT1
All things considered, my using computers is (extremely foolish ~ extremely wise).ATT2
All things considered, my using computers is (extremely unfavorable ~ extremely favorable).ATT3
All things considered, my using computers is (extremely harmful ~ extremely beneficial).ATT4
All things considered, my using computers is (extremely negative ~ extremely positive).ATT5

ACTUAL SYSTEM USE (Al-Gahtani et al., 2007)

On an average working day, how much time do you spend using computers? (1) Almost never; (2) less than30 min; (3) from 30 min
to 1 h; (4) from 1 to 2 h;(5) from 2 to 3 h; and (6) more than 3 h

USE1

On average, how frequently do you use computers?(1) Less than once a month; (2) once a month; (3) a few times a month; (4) a 
few times a week; (5) about once a day; and (6) several times a day

USE2

How many different computer applications have you worked with or used in your job? (1) None; (2) one;(3) two; (4) three to five 
applications; (5) six to ten applications; and (6) more than 10 applications

USE3

According to your job requirements, please indicate each task you use computers to perform (count of all that apply)? (1) Letters 
and memos; (2) producing reports;(3) data storage and retrieval; (4) making decisions;(5) analyzing trends; (6) planning and 
forecasting;(7) analyzing problems and alternatives; (8) budgeting;(9) controlling and guiding activities; (10) electronic 
communications with others; and (11) others (please indicate)

USE4

B.3.2. CREATING PROJECTS WITH SMARTPLS
FIRST STEPS (example)
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 Our database:
o Study about the acceptance and use of a technology “desktop computers for any work-related 

purpose” in Saudi Arabia;

o 1.190 responses from a survey;

o Respondents: white collar workers;

oMultiple industries and companies.

 Available in:
o https://www.smartpls.com/documentation/sample-projects/tam

 Reference:
oAnderson, C., Al-Gahtani, S. S., and Hubona, G. S. (2011). The Value of TAM Antecedents in Global 

IS Development and Research. Journal of Organizational and End User Computing, 23(1), 18-37.

B.3.2. CREATING PROJECTS WITH SMARTPLS
FIRST STEPS (example)

 Let’s setup our model. Two options:

Option 1: draw latent variables (use Latent
Variable button or Alt+2), and then drag the

items of each latent variable…

Option 2: Drag the items of each latent
variable. A latent variable is created

automatically. To select multiple items, 
maintain Ctrl key pressed and select the items.

B.3.2. CREATING PROJECTS WITH SMARTPLS
FIRST STEPS
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 Let’s setup our model. Two options:

B.3.2. CREATING PROJECTS WITH SMARTPLS
FIRST STEPS

1. Each Latent variable needs
to be named. Include the
name of the variable and

press ENTER.

2. Relate the variables as in the conceptual 
framework. Use Connect button or Alt+3

B.3.2. CREATING PROJECTS WITH SMARTPLS
FIRST STEPS
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3. After doing the previous tasks, the latent
variables turn blue.

Everything is ready to start the estimation.

B.3.2. CREATING PROJECTS WITH SMARTPLS
FIRST STEPS

B.3.2. CREATING PROJECTS WITH SMARTPLS
FIRST STEPS

4. Let’s do a “software 
jam session” on all

buttons and sections.
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SmartPLS Procedures B.3.3

Two main procedures:

oPLS Algorithm;

oBootstrapping.

B.3.3. SMARTPLS PROCEDURES
INTRODUCTION
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 In PLS path modeling, parameter estimation is accomplished through a 
multi-stage algorithm.

Stages involve a sequence of regressions in terms of weight vectors.

oIteration leads to convergence on a final set of weights.

Weight vectors obtained at convergence satisfy fixed point equations.

B.3.3. SMARTPLS PROCEDURES
PLS ALGORITHM

This calculation is important mainly for the measurement model:

oStandardized loadings of the items;

oReliability and validity assessment;

oExplained variance of the endogenous variables;

oMulticollinearity assessment.

oIt uses the CCA - Confirmatory Composite Analysis (and not the CFA -
Confirmatory Factor Analysis, like in CB-SEM).

B.3.3. SMARTPLS PROCEDURES
PLS ALGORITM
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B.3.3. SMARTPLS PROCEDURES
PLS ALGORITM

1. To run the PLS-SEM Algoritm, go to 
Calculate tab > PLS Algorithm

or
Calculate icon > PLS Algorithm

B.3.3. SMARTPLS PROCEDURES
PLS ALGORITM

2. Press Start Calculation
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B.3.3. SMARTPLS PROCEDURES
PLS ALGORITM

3. Analyse the values of the item 
loadings

4. Analyse the path coeffficients.

5. Analyse the R2 of endogenous
variables.

B.3.3. SMARTPLS PROCEDURES
PLS ALGORITM
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6. Analyse Report.

B.3.3. SMARTPLS PROCEDURES
PLS ALGORITM

B.3.3. SMARTPLS PROCEDURES
PLS ALGORITM

7. Analyse data from the default report.
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8. Again:
Jam session on the report.

B.3.3. SMARTPLS PROCEDURES
PLS ALGORITM

Bootstrapping provides t-values for:

oInner (structural) model path coefficients;

oOuter (measurement) model item loadings.

Bootstrapping procedure provides mean values for:

oWeights in the inner (structural) model;

oWeights in the outer (measurement) model;

oOuter (measurement) model item loadings.

B.3.3. SMARTPLS PROCEDURES
 BOOTSTRAPPING
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This calculation is important for both the measurement and structural 
models:

oEstimates t-values of item (factor) loadings (outer model) and path coefficients (inner 
model);

oEstablish a number of subsamples to be created (e.g. 500, 1000, 5000);

oRandomly selects the same number of cases of the original database (with 
replacement), and estimates the model 500 (or 1000, or 5000) times;

oCases are drawn with the probability of 1/(nb. of cases) from the data set (a specific 
case may be selected 0 to (nb. of cases) times when creating a bootstrap subsample).

B.3.3. SMARTPLS PROCEDURES
BOOTSTRAPPING

B.3.3. SMARTPLS PROCEDURES
BOOTSTRAPPING

1. To run the Bootstrapping, go to 
Calculate icon > Bootstrapping

or
Calculate tab > Bootstrapping
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B.3.3. SMARTPLS PROCEDURES
BOOTSTRAPPING

3. Define test type and significance level. 
By default two-tailed and significance level

of 0.05.

2. Define the number of subsamples. 
Initial assessment: 500 is enough. 

Final results: 5000 is adequate.

4. Press ‘Start calculation’

B.3.3. SMARTPLS PROCEDURES
 BOOTSTRAPPING

5. Analyse the P values or T-statistics of
the outer loadings. 

6. Analyse the P values or T-statistics of
the path coefficients.
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B.3.3. SMARTPLS PROCEDURES
 BOOTSTRAPPING

7. To change P values / T values, use 
these commands.

B.3.3. SMARTPLS PROCEDURES
 BOOTSTRAPPING

8. Analyse Report.
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B.3.3. SMARTPLS PROCEDURES
 BOOTSTRAPPING

9. Analyse data from the report.

B.3.3. SMARTPLS PROCEDURES
 BOOTSTRAPPING

10. Again:
Jam session on the report.
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Evaluating PLS-SEM Models B.3.4

B.3.4. EVALUATING PLS-SEM MODELS
 STEPS

 The two-stages process is followed (Hair et al., 2021):
 STAGE 1: Measurement model
 STAGE 2: Structural model.

 Measurement Models:
 Reflective measurement models;
 Formative measurement models;

 Structural Models.

Reliability

Assessment of effects
Assessment of prediction quality

 
Validity
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Outer loadings

B.3.4. EVALUATING PLS-SEM MODELS
 STEPS

 ASSESSMENT OF REFLECTIVE MEASUREMENT MODELS:

A - Indicator Reliability

Cronbach’s alfa (); Composite reliability (CR). 

B - Internal Consistency

Average Variance Extracted (AVE). 

C - Convergent Validity

Fornell-Larcker criterion; HTMT; Cross loadings. 

D - Discriminant Validity

 The item loadings should be higher than 0.70 (Hair et al., 2017; Hair et al., 2019).
 Hence, the squared loadings are approximately higher than 0.50.

B.3.4. EVALUATING PLS-SEM MODELS
 STEPS

 ASSESSMENT OF REFLECTIVE MEASUREMENT MODELS:

A - Indicator Reliability

There is an issue here. We
can drop this indicator if it is

problematic.
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 The Cronbach’s alphas need to be higher than 0.70 (or 0.60) (Hair et al., 2019).
 The composite reliabilities need also to be higher than 0.70.

B.3.4. EVALUATING PLS-SEM MODELS
 STEPS

 ASSESSMENT OF REFLECTIVE MEASUREMENT MODELS:

B - Internal Consistency

All the constructs show 
and CR above 0.70.

 Average Variance Extracted (AVE) should be higher than 0.50 (Hair et al., 2019).

B.3.4. EVALUATING PLS-SEM MODELS
 STEPS

 ASSESSMENT OF REFLECTIVE MEASUREMENT MODELS:

C – Convergent Validity

All the constructs show AVE
above the threshold of 0.50.
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 Fornell & Larcker (1981): the AVE for each variable
needs to be higher than the correlation between
that variable and all the other variables.

B.3.4. EVALUATING PLS-SEM MODELS
 STEPS

 ASSESSMENT OF REFLECTIVE MEASUREMENT MODELS:

D - Discriminant Validity

Fornell & Larcker rule is
fulfilled.

 Heterotrait-monotrait Ratio: needs to be below 0.90
for all the latent variables (Hair et al., 2019).

B.3.4. EVALUATING PLS-SEM MODELS
 STEPS

 ASSESSMENT OF REFLECTIVE MEASUREMENT MODELS:

D - Discriminant Validity

HTMT values are within the
limits.
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 Cross-loading: the loadings with the related latent
variables should be higher than the loadings with
the other variables included in the model
(Hair et al., 2017).

B.3.4. EVALUATING PLS-SEM MODELS
 STEPS

 ASSESSMENT OF REFLECTIVE MEASUREMENT MODELS:

D - Discriminant Validity

All the loadings are higher
for the related latent

variables than for the others.

Do the indicators or items “make sense”? Do they comprehensively capture the essence of the latent factor?

B.3.4. EVALUATING PLS-SEM MODELS
 STEPS

 ASSESSMENT OF FORMATIVE MEASUREMENT MODELS:

Indicator relevance/ 
Content Validity

Outer Weights of formative indicators.

Indicator Significance

Variance Inflaction Factor (VIF). 

Multicollinearity

Redundancy analysis; or Nomological Validity.
Or with other constructs indicated by the theory (nomological validity)?

Convergent Validity
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 Include a comprehensive set of indicators that exhausts the formative LV.
 Should be identified by using a rigorous qualitative approach (e.g. experts assessment)
 Perform a literature review to guarantee a theoretical grounding during the process of construction of the 

measures (Hair et al., 2017).
 Example:

B.3.4. EVALUATING PLS-SEM MODELS
 STEPS

 ASSESSMENT OF FORMATIVE MEASUREMENT MODELS:

Indicator relevance

Satisfaction

The service is good.

The personnel is friendly.

The rooms are clean.

Source: Adapted from Albers, 2010.

Indicator relevance/ 
Content Validity

 Redundancy analysis
 High correlation between the formative measure of LV and a different measure for the same LV (reflective).  

Should be higher than 0,7 or R2 of endogenous LV above 0,50.(Hair et al., 2017). 

 Example:

 Other possibility is to relate with a global item (single item LV).

 Or with other LV indicated by the theory (nomological validity).

B.3.4. EVALUATING PLS-SEM MODELS
 STEPS

 ASSESSMENT OF FORMATIVE MEASUREMENT MODELS:

Convergent validity

Satisfaction

I appreciate this hotel.

I’ am looking forward to staying 
in this hotel

I recommend this other to 
others.

Satisfaction

The service is good.

The personnel is friendly.

The rooms are clean.

Source: Adapted from Albers, 2010.
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B.3.4. EVALUATING PLS-SEM MODELS
 STEPS

 ASSESSMENT OF FORMATIVE MEASUREMENT MODELS:

 Look at VIF of the formative LV.
 VIF needs to be below the value of 5,0 (Hair et al., 2011; Hair et al., 2017).

 If the level of collinearity is higher than 5,0 for a LV, some item needs to be removed. It is necessary to have 
VIF<5,0 to advance with the analysis.

 What item?
 One that exhibits bivariate correlations above 0,60.
 Still, the remaining indicators need to capture the construct’s content from theoretical perspective.

Multicollinearity

B.3.4. EVALUATING PLS-SEM MODELS
 STEPS

 ASSESSMENT OF FORMATIVE MEASUREMENT MODELS:

 We need to analyses the outer weights of the formative LV.

 The outer weights in formative measurement are usually bellow than the outer loadings of reflective LV (Hair et 
al., 2017).

 The outer weights of the indicators of formative LV, need to be significant (Hair et al., 2017).

Indicator Significance
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B.3.4. EVALUATING PLS-SEM MODELS
 STEPS

 ASSESSMENT OF STRUCTURAL MODELS:
o If the existing goodness-of-fit measures were widely accepted, it would be helpful… (GoF, SEME, 

RMStheta…)

o So, usually the following results are presented:

1. Analysis of collinearity (VIF);

2. Coefficients of determination (R2);

3. Effect size (f2);

4. Predictive relevance (Q2).

5. Size and significance of path coefficients (hypotheses evaluation).

B.3.4. EVALUATING PLS-SEM MODELS
 STEPS

 ASSESSMENT OF STRUCTURAL MODELS:
1. Analysis of collinearity (VIF)

• VIF values need to be below 5,0 (Hair et al., 2019).

 TAM example:

All the VIF values are 
below the cutoff 5,0.
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B.3.4. EVALUATING PLS-SEM MODELS
 STEPS

 ASSESSMENT OF STRUCTURAL MODELS:
2. Coefficients of determination (R2)

• Examine the R2 of the endogenous LVs. Evaluation (Hair et al., 2011):
• R2 >0,75 – Substantial;
• 0,50>R2 >0,75 – Moderate;
• 0,25>R2 >0, 50 – Weak.

• Even so, sometimes to present values above 0,10 is considered satisfactory (Raithel et al., 2012; Falk & Miller, 1992).

 TAM example:

Three variables show 
R2 above 0,10, but

one of the variables
show a very weak R2

(R2=0,052).

B.3.4. EVALUATING PLS-SEM MODELS
 STEPS

 ASSESSMENT OF STRUCTURAL MODELS:
3. Effect size (f2)

• Assesses the relevance of removing an exogenous LV as a specific predictor of an endogenous LV. Rules of thumb (Cohen, 
1988; Hair et al., 2017):

• f2 >0,35 – large effect size;
• 0,15>f2 >0,35 – medium effect size;
• 0,02>f2 >0,15 – small effect size.

 TAM example:

Small Effect sizes

Medium Effect sizes
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B.3.4. EVALUATING PLS-SEM MODELS
 STEPS

 ASSESSMENT OF STRUCTURAL MODELS:
4. Predictive relevance (Q2)

• Uses the blindfolding procedure. Removes specific values of the samples and replaces those values by the mean and 
estimates the model parameters (Rigdon, 2014).

• Small differences between the predicted and the initial values lead to higher Q2, so higher predictive relevance. 
Reference values (Hair et al., 2019):  

• Q2>0,50 – large predictive relevance;
• 0,25>Q2>0,50 – medium predictive relevance;
• 0,0>Q2>0,25 – small predictive relevance.

• How to obtain Q2?
• Follow the path:

• Calculate > PLSpredict > PLS setup > Start calculation
• Report:

• LV prediction summary

B.3.4. EVALUATING PLS-SEM MODELS
 STEPS

 ASSESSMENT OF STRUCTURAL MODELS:
4. Predictive relevance (Q2)

• Uses the blindfolding procedure. Removes specific values of the samples and replaces those values by the mean and 
estimates the model parameters (Rigdon, 2014).

• Small differences between the predicted and the initial values lead to higher Q2, so higher predictive relevance. 
Reference values (Hair et al., 2019):  

• Q2>0,50 – large predictive relevance;
• 0,25>Q2>0,50 – medium predictive relevance;
• 0,0>Q2>0,25 – small predictive relevance.

 TAM example:

Small predictive relevance
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B.3.4. EVALUATING PLS-SEM MODELS
 STEPS

 ASSESSMENT OF STRUCTURAL MODELS:
5. Size and significance of path coefficients (hypotheses evaluation).

 TAM example:

Analysis of path coeffficients.

 TAM example:

B.3.4. EVALUATING PLS-SEM MODELS
 STEPS

 ASSESSMENT OF STRUCTURAL MODELS:
5. Size and significance of path coefficients (hypotheses evaluation).

Analysis of T-statistics of the path 
coefficients.
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Mediation B.3.5

 A variable functions as a mediator when it meets 
the following conditions (Baron & Kenny, 1986):

o Variations in levels of the independent variable 
significantly account for variations in the 
presumed mediator (i.e. Path a)

o Variations in the mediator significantly account 
for variations in the dependent variable (i.e. Path 
b), and

oWhen paths a and b are controlled, a previously 
significant relation between the independent and 
dependent variables (i.e. Path c) is no longer 
significant.

B.3.5. MEDIATION
DEFINITION

Mediator
Variable

Independent
Variable

Dependent
Variable

Path bPath a

Path c
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 Partial Mediation:

o The independent variable still has a significant direct 
effect on the dependent variable.

o The magnitude of the influence of Path c is diminished 
(but still significant) upon introducing the mediator 
variable (and Paths a and b).

 Full Mediation:

o The independent variable does not have a significant 
effect on the dependent variable after inclusion of the 
mediator variable. That is, the effect of the 
independent variable on the dependent variable is not 
significantly different from zero.

o The magnitude of the effect of Path c drops to zero.

B.3.5. MEDIATION
DEFINITION

Mediator
Variable

Independent
Variable

Dependent
Variable

Path bPath a

Path c

Sometimes in SEM, the mediating effects are suggested but often not explicitly 
tested.
oFor example, it is already known that social presence impact on trust and enjoyment in 

online environments, but few studies investigate whether this social presence mediates 
the influence of other variables on trust and enjoyment.

oFor example, consider this research model: 

oOur database:
 Study about the online shopping experiences;

 216 responses from a survey;

 Respondents: online shoppers;

 They were identified as online shoppers in
an online clothing store.

B.3.5. MEDIATION
Example

Perceived
Social 

Presence

Telepresence Enjoyment

Trust

Perceived
Usefulness

H1

H2
H3

H4

H5
H6
H7

147

148



PROGRAMA DE DOUTORAMENTO EM GESTÃO
Técnicas Quantitativas de Investigação em Gestão

© Nuno Crespo 2023 75

Measures:
PERCEIVED SOCIAL PRESENCE (Gefen & Straub, 2003)
(seven-point Likert scale anchored with strongly disagree to strongly agree)

There was a sense of human contact on the [X vendor site/Internet e-commerce site].PSP1
There was a sense of sociability on the [X vendor site/Internet e-commerce site].PSP2
There was a sense of human warmth on the [X vendor site/Internet e-commerce site].PSP3

TELEPRESENCE (Kim & Biocca, 1997)
(seven-point Likert scale anchored with strongly disagree to strongly agree)

I forget about my immediate surroundings when I am on the [X vendor site/Internet e-commerce site].TL1
Browsing the [X vendor site/Internet e-commerce site] often makes me forget where I am.TL2
After browsing the [X vendor site/Internet e-commerce site], I feel like I come back to the “real world” after a journey.TL3
Using a [virtual world/web site] creates a new world for me, and this world suddenly disappears when I stop using it.TL4

PERCEIVED USEFULNESS (Chen, Gillenson & Sherrell, 2002; Moon & Kim, 2001)
(seven-point Likert scale anchored with strongly disagree to strongly agree)

The [X vendor site/Internet e-commerce site] provided good quality information.PU1
The [X vendor site/Internet e-commerce site] improved my performance in assessing product features.PU2
The [X vendor site/Internet e-commerce site] increased my effectiveness in assessing product features.PU3
The [X vendor site/Internet e-commerce site] was useful for assessing product features.PU4

B.3.5. MEDIATION
Example

Measures:
TRUST (Gefen, Karahanna & Straub, 2003)
(seven-point Likert scale anchored with strongly disagree to strongly agree)

I felt that the [X vendor site/Internet e-commerce site] was honest.TRS1
I felt that the [X vendor site/Internet e-commerce site] was trustworthy.TRS2
I felt that the [X vendor site/Internet e-commerce site] cared for customers.TRS3
I felt that the [X vendor site/Internet e-commerce site] provided me with good service.TRS4

ENJOYMENT (Koufaris, 2002; Agarwal & Karahanna, 2000)
(seven-point Likert scale anchored with strongly disagree to strongly agree)

I found my visit to the [X vendor site/Internet e-commerce site] to be interesting.ENJ1
I found my visit to the [X vendor site/Internet e-commerce site] to be entertaining.ENJ2
I found my visit to the [X vendor site/Internet e-commerce site] to be enjoyable.ENJ3
I found my visit to the [X vendor site/Internet e-commerce site] to be pleasant.ENJ4

B.3.5. MEDIATION
Example
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The results of the structural (inner) model are:

Telepresence seemingly has no impact on trust, has a positive impact on 
enjoyment and a negative on perceived usefulness.

B.3.5. MEDIATION
Example

Perceived
Social Presence

R2=21.7%

Telepresence Enjoyment
38.9%

Trust
R2=15.9%

Perceived
Usefulness

R2=7.9%

0.557***

0.316***

0.386***0.465***

-0.186*

0.026

0.122*

Let’s try to get there with the file: RetailSite.csv.

Analyse the measurement model
o Reliability;

o Validity;

Analyse the structural model.

B.3.5. MEDIATION
Example
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Something like this?

B.3.5. MEDIATION
Example

Tvalue
4,946

Tvalue
8,168

Tvalue
6,874

Tvalue
2,477

Tvalue
10,249

Tvalue
0,396

Tvalue
2,087

Something like this?

B.3.5. MEDIATION
Example

***

*** ***
**

*** n.s.

*
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What if we omit the perceived social presence (mediator)?

Now, telepresence has a significant direct effect on both trust and 
enjoyment (but not on perceived usefulness).

B.3.5. MEDIATION
Example

Telepresence Enjoyment
R2=15.0%

Trust
R2=4.4%

Perceived
Usefulness

R2=0.3%

-0.050

0.209***

0.388***

Something like this?

B.3.5. MEDIATION
Example

***

***

n.s.
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So, it seems that:

oThe direct effect that telepresence has on trust, is fully mediated by 
perceived social presence.

oThe direct effect that telepresence has on enjoyment, is partially mediated 
by perceived social presence.

B.3.5. MEDIATION
Example

Moderation Effects B.3.6
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B.3.6. MODERATION EFFECTS

 How depict moderating effects in a PLS Path Model when the 
software only permits drawing direct effects?

 How estimate and interpret the coefficients of moderating 
effects?

 How determine the significance of moderating effects?

 How do formative versus reflective latent variables influence 
the detection, estimation and interpretation?

 Before model estimation, how prepare the data?

o Should indicators be centered? (e.g. mean of zero);

o Should indicators be standardized? (e.g. mean of zero and 
standard deviation of one)

oManipulated in some other way?

Moderation
Variable

Independent
Variable

Dependent
Variable

B.3.6. MODERATION EFFECTS
WHAT’S THE RELEVANCE?

 Simply investigating the direct impact of one exogenous latent variable upon an endogenous 
variable belies the possibility of more complex, ‘cascading’ cause-and-effect relationships.

o Especially with respect to human behavior.

o For example, consider the factors that influence what clothes you might wear on any particular 
day:

• Function you are attending

• People you will be around

• Weather (hot/cold; wet/dry; sunny/cloudy; seasonal influences; etc.)

 Moderating effects are not regarded, even if literature points out their relevance for explaining 
complex cause-effect relationships.

• For example, levels of experience and age using computer technology is known to impact technology 
acceptance, but, usually, studies do not look for interactions of experience with other exogenous variables on 
technology acceptance.
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B.3.6. MODERATION EFFECTS
TWO APPROACHES

APPROACH 1
 Introduce and evaluate interaction terms in the structural model

oAlso called product indicator approach
o Best for continuous moderator variables
o Independent and moderator variables are both reflective.

APPROACH 2
 Determining moderating effects through group comparisons

oBest for categorical moderator variables, or otherwise non-continuous and discrete variables.
oOr they can be made discrete (e.g. high value – low value groupings)
oAlso must be reflective indicators.

B.3.6. MODERATION EFFECTS
INTERACTION

 Involves a moderator variable which may be:

o Qualitative (e.g. gender, race, …)

o Quantitative (e.g., age, income, firm size, …)

 The moderator, in turn, affects the direction and/or strength of the relation between the independent (or 
predictor) variable and a dependent (or criterion) variable.

 Thus, moderator variables provide information as to the conditions in which we would expect a relationship 
between two variables to exist.

 SmartPLS offers a latent variable modeling approach for better estimation and detection of the interaction effect 
between quantitative (i.e., continuous) predictor and moderator variables.

 Product Indicator approach:

o Product term (x*z) used to examine the influence that a moderator z would have on the relationship between the 
predictor x and the dependent variable of interest y.
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B.3.6. MODERATION EFFECTS
INTERACTION

 Shall we start with this model? 

 We will now include a variable related with the total expense of the items in the online store.

B.3.6. MODERATION EFFECTS
INTERACTION

 Let’s test if the total expense moderates the impact of telepresence in trust and enjoyment:

or
1b. Click on the ‘Connect’ 

option.

1a. Click on the Moderation
Effect option

2. Then, draw a line between
de moderator variable and
the relationship that you

want to moderate.
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B.3.6. MODERATION EFFECTS
INTERACTION

 Let’s test if the total expense moderates the impact of telepresence in trust and enjoyment:

3 . Then, you should simply
run the Bootstapping!

Note: our variable was only a 
single item variable. Otherwise, 

we need to run the PLS-SEM 
Algorithm and check for validity
and reliability of the moderator

variable.

B.3.6. MODERATION EFFECTS
INTERACTION

 Now the results:

4. Looks like we 
have something...
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B.3.6. MODERATION EFFECTS
INTERACTION

 How about a graphical analysis of this moderation effect?

6. Calculate > PLS-SEM 
Algorithm > Start

calculation

B.3.6. MODERATION EFFECTS
INTERACTION

 How about a graphical analysis of this moderation effect?

6. Report > 
Simple slope

analysis

7. The slope here
is more steeper, 
don’t you think?
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B.3.6. MODERATION EFFECTS
MULTIGROUP ANALYSIS

 The same model? 

B.3.6. MODERATION EFFECTS
MULTIGROUP ANALYSIS

 We will now include a variable related with the total expense as the variable that enables the 
construction of groups.

1. Go to the data set.
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B.3.6. MODERATION EFFECTS
MULTIGROUP ANALYSIS

 We will now include a variable related with the total expense as the variable that enables the 
construction of groups.

2. Click on
‘Add Group’.

B.3.6. MODERATION EFFECTS
MULTIGROUP ANALYSIS

 We saw that amount has a mean value of 191,5 euros.

 We will define 2 groups:

 High: values  191 euros

 Low: values <191 euros

3. Define group names.

4. Define the terms or
each group.
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B.3.6. MODERATION EFFECTS
MULTIGROUP ANALYSIS

 We get these two groups:

5. Group high with 117 cases 
and group low with 99 cases.

6. Back to the project.

B.3.6. MODERATION EFFECTS
MULTIGROUP ANALYSIS

 Now the analysis:

7. Select ‘Bootstrap multiple
analysis’.
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B.3.6. MODERATION EFFECTS
MULTIGROUP ANALYSIS

 Now the analysis:

9. Start Calculation.

8. Allocate the goups.

B.3.6. MODERATION EFFECTS
MULTIGROUP ANALYSIS

 Results:

11 … one diference is
significant.

10. Some diferences of
results between groups, 

and…
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Second-order variables B.3.7

 In the last years, the use of PLS-SEM methods moved 
from simple and small models to more advanced model 
designs, like higher-order constructs (Sarstedt et al., 
2019).

 Higher-order constructs, can also be called as 
hierarchical component models  in the PLS-SEM.

 It refers to a specific framework where a latent variable 
(or construct) on a more abstract facet (like a second-
order construct) combines different dimensions (like 
first-order constructs). Therefore, these latent variables 
have additional layers of abstraction, when compared to 
first order constructs.

B.3.7. SECOND-ORDER LATENT VARIABLE
DEFINITION

2nd OC

1st OC 
A

1st OC 
B

1st OC 
C

x1

x2

x3

x4

x5

x6

x7

x8

x9
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 Some advantages of high-order constructs:

o It helps to reduce the number of path model relationships within the frameworks – reduce complexity;

o It helps to overcome the bandwidth-fidelity dilemma;

o Higher-order constructs help to reduce collinearity between formative indicators (because they are rearranged in 
subdimensions).

 Main concerns related with the development of high-order constructs:

o The conceptualization and specification of a high-order construct needs to be grounded in a well-supported measurement 
theory (reflective-R/formative-F) – there are four types of high-order constructs (RR, RF, FR, FF);

o There are different approaches to specify high-order constructs (repeated indicator approach, two-stage approach and 
hybrid approach);

o The evaluation of the measurement quality of high-order constructs needs to be assessed separately.

B.3.7. SECOND-ORDER LATENT VARIABLE
DEFINITION

References: Hair et al., 2018; Sarstedt et al., 2019

There are four types of high-order constructs:

B.3.7. SECOND-ORDER CONSTRUCTS
TYPES

Reflective -
Reflective

Reflective -
Formative

Formative -
Reflective

Formative -
Formative

HOC

LOC1

LOC2

LOC2

x1

x2

x3

x4

x5

x6

x7

x8

x9

HOC

LOC1

LOC2

LOC2

x1

x2

x3

x4

x5

x6

x7

x8

x9

HOC

LOC1

LOC2

LOC2

x1

x2

x3

x4

x5

x6

x7

x8

x9

HOC

LOC1

LOC2

LOC2

x1

x2

x3

x4

x5

x6

x7

x8

x9
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 Some advantages of high-order 
constructs: In the last years, the use of 
PLS-SEM method moved from simple 
and small models to more advanced 
model designs, like higher-order 
constructs (Sarstedt et al., 2019).

 Three different approaches to model 
hierarchical latent variables in PLS-SEM:

o The repeated indicator approach;

o The two-stage approach or sequential 
latent variable score method;

o The hybrid approach.

B.3.7. SECOND-ORDER LATENT VARIABLE
DEFINITION

2nd OC

1st OC 
A

1st OC 
B

1st OC 
C

x1

x2

x3

x4

x5

x6

x7

x8

x9

REFLECTIVE-REFLECTIVE:

oOpen the file “Strategies_red.sav”;

oReplicate the model presented below:

B.3.7. SECOND-ORDER LATENT VARIABLE
 EXAMPLE

Entrepreneurial
Orientation

Innovativeness

Proactiveness

Risk-Taking

EO_it1
EO_it2
EO_it3

EO_it4
EO_it5
EO_it6

EO_it7
EO_it8
EO_it9

International
Performance

Competitive
Aggressiveness

EO_it10
EO_it11

IPer_it1
IPer _it2
IPer _it3
IPer _it4
IPer _it5
IPer _it6
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REFLECTIVE-REFLECTIVE:

B.3.7. SECOND-ORDER LATENT VARIABLE
 EXAMPLE

1. Like this. Now run the usual Processes: 
 PLS-SEM Algorithm
 Bootstrapping

2. Attention: All EO items need also to be
here.

REFLECTIVE-REFLECTIVE:

B.3.7. SECOND-ORDER LATENT VARIABLE
 EXAMPLE

3. Results of PLS-SEM Algorithm.
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REFLECTIVE-REFLECTIVE:

B.3.7. SECOND-ORDER LATENT VARIABLE
 EXAMPLE

4. Results of Bootstrapping.

REFLECTIVE-FORMATIVE:
oConsider that, based on theoretical support, Entrepreneurial Orientation had 4 formative 

dimensions:

oReplicate the model presented below:

B.3.7. SECOND-ORDER LATENT VARIABLE
 EXAMPLE

Entrepreneurial
Orientation

Innovativeness

Proactiveness

Risk-Taking

EO_it1
EO_it2
EO_it3

EO_it4
EO_it5
EO_it6

EO_it7
EO_it8
EO_it9

International
Performance

Competitive
Aggressiveness

EO_it10
EO_it11

IPer_it1
IPer _it2
IPer _it3
IPer _it4
IPer _it5
IPer _it6
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REFLECTIVE-REFLECTIVE:

B.3.7. SECOND-ORDER LATENT VARIABLE
EXAMPLE

1. Like this. Now try to run PLS-SEM 
Algorithm.

REFLECTIVE-REFLECTIVE:

B.3.7. SECOND-ORDER LATENT VARIABLE
 EXAMPLE

2. Results of PLS-SEM Algorithm. 
Everything seems ok…

3. But, we obtain this R2=100%, or 1,000. 
This does not make sense.
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REFLECTIVE-REFLECTIVE:

B.3.7. SECOND-ORDER LATENT VARIABLE
 EXAMPLE

4. Go to the report > Latent Variables > 
Scores

REFLECTIVE-REFLECTIVE:

B.3.7. SECOND-ORDER LATENT VARIABLE
 EXAMPLE

5. Click on ‘Create data file’

6. Select Manifest variable scores + Latent
variable scores

7. Click on create.

8. Press ‘Back’.
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REFLECTIVE-REFLECTIVE:

B.3.7. SECOND-ORDER LATENT VARIABLE
 EXAMPLE

9. Press ‘Save’.

10. Click on Select dataset.

REFLECTIVE-REFLECTIVE:

B.3.7. SECOND-ORDER LATENT VARIABLE
 EXAMPLE

11. We now have these new observed
variables, one for each dimension/LV.

12. So, we will delete the second-order
variables, and replace them by the new

observed dimensions.
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REFLECTIVE-REFLECTIVE:

B.3.7. SECOND-ORDER LATENT VARIABLE
 EXAMPLE

14. Now we can run the PLS-SEM 
Algorithm, and analyse EO like a normal 

formative variable.

13. Like this!

REFLECTIVE-REFLECTIVE:

B.3.7. SECOND-ORDER LATENT VARIABLE
 EXAMPLE

15. Like this!
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Q&A

REFERENCES

 Albers, S. (2010). PLS and success factor studies in marketing. In Handbook of partial least squares (pp. 409-425). Springer, Berlin, Heidelberg. 
 Bagozzi, R. P., & Fornell, C. (1982). Theoretical Concepts, Measurements, and Meaning. A Second Generation of Multivariate Analysis, New York: Praeger. 
 Barclay, D., C. Higgins, and R. Thompson, "The partial least squares (PLS) approach to causal modeling: Personal computer adoption and use as an illustration," Technology Studies, 1995, 2(2), pp. 285–309. 
 Baron, R. M., & Kenny, D. A. (1986). The moderator–mediator variable distinction in social psychological research: Conceptual, strategic, and statistical considerations. Journal of personality and social psychology, 51(6), 

1173. 
 Cepeda-Carrión, G. C., Henseler, J., Ringle, C. M., & Roldán, J. L. (2016). Prediction-oriented modeling in business research by means of PLS path modeling: Introduction to a JBR special section. Journal of business 

research, 69(10), 4545-4551. 
 Chin, W.W., "The partial least squares approach to structural equation modeling," In Modern Methods for Business Research, Marcoulides, G.A. (ed.), Lawrence Erlbaum Associates, Mahwah, NJ, 1998b, pp. I295–1336. 
 Falk, R. F., & Miller, N. B. (1992). A primer for soft modeling. University of Akron Press.
 Fornell, C., & Larcker, D. F. (1981). Evaluating structural equation models with unobservable variables and measurement error. Journal of Marketing Research, 18(1), 39-50.
 Gefen, D., Rigdon, E. E., & Straub, D. (2011). Editor's comments: an update and extension to SEM guidelines for administrative and social science research. MIS Quarterly, 35(2); iii-xiv.
 Kline, R. B. (2005). Principles and Practice of Structural Equation Modeling (2nd ed.). New York: Guilford.
 Hair Jr, J. F., Hult, G. T. M., Ringle, C. M., & Sarstedt, M. (2017). A primer on partial least squares structural equation modeling (PLS-SEM). California: Sage publications.
 Hair Jr, J. F., Black, W. C., Babin, B. J.., & Anderson, R. E. (2019). Multivariate Data Analysis. Hampshire: Cengage Learning.
 Hair, J.F., Ringle, C.M., & Sarstedt, M. (2011). PLS-SEM: Indeed a silver bullet. The Journal of Marketing Theory and Practice, 19(2), 139-152. 
 Hair, Joseph F., Jeffrey J. Risher, Marko Sarstedt, and Christian M. Ringle. (2021) "When to use and how to report the results of PLS-SEM." European Business Review, 31(1), 2-24. 
 Lohmöller, J. B., & Wold, H. (1980). Three-Mode Path Models with Latent Variables and Partial Least Squares (PLS) Parameter Estimation. Presented at the European Meeting of the Psychometrics Society, Groningen, 

The Netherlands.
 Raithel, S., Sarstedt, M., Scharf, S. and Schwaiger, M. (2012), “On the value relevance of customer satisfaction. multiple drivers and multiple markets”, Journal of the Academy of Marketing Science, 40 (4), 509-525.
 Rasoolimanesh, S. M., & Ali, F. (2018). Editorial: partial least squares (PLS) in hospitality and tourism research. Journal of Hospitality and Tourism Technology, 9(3), 238-248.
 Rigdon, E.E. (2014), “Rethinking partial least squares path modeling: breaking chains and forging ahead”, Long Range Planning, Vol. 47 No. 3, pp. 161-167.
 Rigdon, E. E., Sarstedt, M., & Ringle, C. M. (2017). On comparing results from CB-SEM and PLS-SEM: Five perspectives and five recommendations. Marketing: ZFP–Journal of Research and Management, 39(3), 4-16. 
 Sarstedt, M., Ringle, C. M., & Hair, J. F. (2014). PLS-SEM: Looking back and moving forward. Long Range Planning, 47(3), 132-137.
 Shmueli, G., Ray, S., Estrada, J. M. V., & Chatla, S. B. (2016). The elephant in the room: Predictive performance of PLS models. Journal of Business Research, 69(10), 4552-4564. 
 Temme, D., Kreis, H., & Hildebrandt, L. (2010). A comparison of current PLS path modeling software: Features, ease-of-use, and performance. In Handbook of partial least squares (pp. 737-756). Springer, Berlin, 

Heidelberg. 
 Urbach, N., & Ahlemann, F. (2010). Structural equation modeling in information systems research using partial least squares. Journal of Information technology theory and application, 11(2), 5-40. 
 Wold, H. (1975) Soft modelling by latent variables: Non- linear iterative partial least squares (NIPALS) approach. In: Gani, M.S.B., Ed., Perspectives in Probability and Statistics, Academic Press, London, 117-142.
 Wold, H. (1973). Nonlinear iterative partial least squares (NIPALS) modelling: some current developments. In Multivariate analysis–III (pp. 383-407). Academic Press.

195

196


